
Getting started with Writer’s 
Café 

 
by Harriet Smart 
 

Writer’s Café is a software toolkit for creative writers of all kinds. It consists 
of two main applications – Writer’s Café Desk, and StoryLines. Writer’s Café 
Desk has many functions, while StoryLines is dedicated to the task of story 
structuring. 
 

Writer’s Café is a little different from other fiction writing software 
packages you may have tried. This is because I’ve tried them too and found 
they didn’t help with the specific writing problems that I was trying to solve in 
my work: and many of our customers have reported the same experience. 
 

Successful writing comes when you get into a particular state of mind. 
It’s like shifting into a different gear. Ideas for stories aren’t so very hard to 
come by but transforming them into a successful, well-written narrative is 
another matter entirely. Writer’s Café is designed to be a nurturing 
environment that lets your mind explore all the possibilities. It won’t tell you 
what to do. It won’t churn out pre-drawn plot schedules for you to follow, or 
hinder you by demanding answers to unanswerable questions. It will let you 
relax so that you can jump into the world of your imagination and play there. 
 

I’ve written a 60-page e-book to support the tools which you can find in the 
Bookshelf section (to read within Writers Café) and in the Café Menu (as a 
PDF file, to read or print out using Adobe Acrobat). Fiction: The Facts is a 
distillation of 20 years of writing experience and should help you form a good 
understanding of the art and craft of story. If using Acrobat, try the Full 
Screen view (from the Window menu) and press the Escape key when 
you’re done. 
 

Using Using Using Using Writer’s Café DeskWriter’s Café DeskWriter’s Café DeskWriter’s Café Desk  
The basic elements of Writer’s Café Desk are shown in this picture. There’s 
a menubar and toolbar, the scrapbook index which we’ll explain shortly, and 

a variety of tools, accessed by the tabs underneath 
the toolbar. The tools are Menu, Scraps, StoryLines,
Journal, Notebook, Web, Cookies, and Bookshelf.

Beneath these, there’s a status bar which 
displays the timer display, useful for timed writing. The 
status bar also displays brief help when you’re 
hovering over toolbar buttons and menu items. 

What is 
Writer’s 

Café?

Fiction: The 
Facts
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There’s a variety of ways to get further help. Click on to show online 
help for the tool you’re currently working with. Click on  (or Help | What’s 
This?, or in a dialog box caption) and then on a window to show a 
short description of the window. You can show the online help contents with 
Help | Contents, or you can browse the online help and other Writer’s Café 
documents from the Bookshelf tool. Most dialog boxes also have a Help 
button that shows a detailed description of the dialog box. 

 

Click on the Menu tab to access a variety of tools and documents, including 
our writing guide Fiction: The Facts, StoryLines, the Forty Thieves card 
game, the WordTiles poetry creator, the thesaurus Aiksaurus, and more. If 
you need to get your adrenalin going, turn up the volume and play Untie My 
Tongue by British singer-songwriter Jay Goldmark. 
 

The tools displayed here are also available from the Tools menu, and 
on Windows you can access them by right-clicking on the Writer’s Café tray 
icon and selecting from the Tools menu. 
 

Write a little every day if you can!  
 

If you have been trying to write, but aren’t 
sure what direction to take just yet, the 
Writer’s Café Notebook is the place to explore 
those first thoughts. We’ve designed it as a 
friendly, simple, non-distracting space that 
isn’t dauntingly large. After all, there is nothing 
so scary as a huge sheet of blank paper or an 
empty screen to be filled. If you find yourself 
on a word roll (and we hope you do), the page 
will scroll down as you write. The notebook 
automatically saves your pages and you don’t have to give it a filename 
unless you want to use several notebooks, for example for different projects, 
subjects or stories. 
 

If you are stuck for something to write, try 
pasting one of our writing prompts into the 
notebook and take it from there. To show 
the writing prompt dialog, use the Help | 
Writing Prompt… menu item, or Alt+P, or 
click the button on the toolbar. 
 

If you are really stuck, try setting the 
timer for only ten minutes. You may find it 
easier to focus if you only have to write for 
ten minutes than if you have an unspecified 
amount of time. It is also ideal for when the 
rest of your life is pressing in on you and you are trying to make time for your 
writing. Using the timer, half an hour a day can easily be marked out as your 
special writing time – and become part of your daily routine. You’ll be 
surprised how your material mounts up and you’ll feel you are really 
achieving something. 
 

To use the timer for other purposes, click on the digital clock face on the 
bottom right of the Writer’s Café window, or use View | Timer… or F11.

The Café Menu

Notebook

Writing Prompts,
for instant inspiration
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For many writers, keeping a record of their life and thoughts is a 
fundamental part of their method. It’s certainly a great habit to get into and 
the Writer’s Café Journal is always there to get you writing every day. As 

with the notebook, you can paste in a writing prompt if you are stuck for a 
subject, but it’s your decision. 
 

Remember, you don’t have to write something brilliant every time. Just 
writing is enough. 

 
Access the journal by clicking on the Journal tool tab.  

 
The Scrapbook is a multifunctional space designed to help you explore and 
research your creative projects. It’s like a big pin-board, for all those bits and 
pieces that stir your imagination and you need to keep handy.

You can browse the structure of your scrapbook on the scrapbook 
index, the left-most window in Writer’s Café Desk. You can view the scraps 
themselves in the Scraps tool. 

 
To create a new scrapbook (collection of scraps), click on the toolbar 

button (or Ctrl+N, or File | New Scrapbook) and choose a name and 
filename. Now you can create scraps and folders using the toolbar 
button. Save the scrapbook with (or Ctrl+S, or File | Save Scrapbook)
and open an existing one with (or Ctrl+O, or File | Open Scrapbook). 

 
These are the types of scrap you can create: 

 
Text Scrap: Just type! This is the place for recording those back-of-the-
envelope, inspirational moments. 
 
Image Scrap: You find a great picture in a magazine that says something 
about your story or a photograph of someone who looks just like your 
heroine. This is the spot for keeping them. 
 

Web Link Scrap: Surf in the Web tab and when you find a site that interests 
you and you want to bookmark, click on to store the address as a web 
link scrap. Then when you look at the scrap again, the web site will 
immediately appear (Windows only). 
 
Folder Scrap: you can use this to make hierarchies in your scrapbook. 
 
Shortcut Scrap: store references to documents or programs on your 
computer. Drag a file from Windows Explorer or browse for a file, then click 
on Launch to edit the document or run the program. 
 

Collage Scrap: This is a flexible 
brainstorming tool to encourage blue-sky 
thinking and constructive daydreaming. 
There is a stage in creating a story when 
you have collected a heap of ideas which 
appeal to you but which you can’t get into 
any coherent order. The collage tool 
allows you to lay down ideas in an 
unstructured but graphical form so you 
can see exactly what you’ve got. You can 
put text in shapes, and add images. 

Journal

The Writer’s 
Café Scrapbook
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Everything can be moved about at will, and you can add links with arrows 
between items if you like. You can change all the colours. All in all, it’s a fun 
place to explore your ideas. 
 

And of course the Scrapbook isn’t just useful for writing-related 
organisation. You can use it to plan weekend trips or family celebrations, 
store details if you’re moving house, organise your recipes or CDs – 
whatever you like. 
 

This is a collection of my favourite quotations about writing, randomly 
presented for your sustenance and amusement! 
 

To see a new cookie, press the spacebar or click on the border around 
the cookie. 
 

On Windows, you can browse the web from within 
Writer's Café. This integration means that you 
don’t have the distraction of switching away from 
the writing environment so often, and it’s easy to 
create a web link scrap for the currently-viewed 
site. 

The Writer’s Café manuals and 
Fiction: The Facts book are all  
available from within Writer’s Café 
Desk without using an external help 
viewer. Click on Bookshelf and 
select a book to view. You can 
browse through the topics using the 
Contents tab on the left, or you can 
use the Index or Search tabs to find 
the topic you’re looking for. 
 

Fiction: The Facts is also available as a PDF file for viewing or printing, 
which you can access from the Café Menu tool or the opening Welcome 
screen.  
 

As mentioned above, the Café Menu gives you access to further tools, such 
as Aiksaurus (Windows only), Forty Thieves, and WordTiles as illustrated 
here. 

Cookies

Web 

The Bookshelf

Other tools
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Using Using Using Using StoryLinesStoryLinesStoryLinesStoryLines  
StoryLines is all about helping you to 
develop and transform your ideas 
into a detailed blueprint that you can 
use to write a script or a novel. 
 

Writers have always used scraps 
of paper, blank index cards or 
postcards to record separate 
incidents in their stories and then sort 
them into the best possible order and 
identify the gaps in the story. 
StoryLines takes this concept to the 
next level, allowing you to write and 
record and organise your virtual 
cards really quickly.  

 
Keeping track of a plot, making 

sure it has a unity and a proper 
structure is no easy feat – and these 

days, most stories have more than one plotline. StoryLines allows you to 
plan each plot on a separate line and arrange the events you have recorded 
on the cards to create the best effect. If you have the idea that you want your 
love story to be resolved before the espionage plot plays itself out, 
StoryLines makes it easy to see if that works, and to try out all the 
alternatives without loads of rewriting.  
 

From Writer’s Café Desk, click on the StoryLines tab. You’ll see a clickable 
list of all your recent StoryLines projects so your current work is never far 
away. From here you can click on a project, or launch the StoryLines 
application. 
 

Click on (or File | New Project or 
Ctrl+N) to start creating a new 
project. StoryLines asks you to give a 
name for your project, and to name 
up to three storylines. You only need 
to name one storyline, and the name 
can be quite arbitrary, so don’t worry 
if you haven’t got all the details 
straight in your mind. You can easily 
add or delete storylines at any time. 
 

How to 
open StoryLines

Creating a 
StoryLines project
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StoryLines is divided into three main areas. 
 

The project outline on the left, where you 
can see a bird’s eye view of your story.  
 

The card editor pane on the right, where 
you enter text and other details for each card. 
You can also record project notes and view 
reports. 
 

The storyline window at the bottom 
where you arrange your cards. 
 

To add a new card, click on (or type Ctrl+N, or Edit | New Card). 
You can now start typing text into the Description tab of the card editor, and 
create further cards, dragging them to the appropriate storyline. To keep 
creating cards on a specific storyline, select the storyline from the drop-down 
list on the toolbar. 

 
You’ll see the cards being added to the outline, and you can click on an 

item in the outline to go to that card quickly. Click on the Reports tab to see 
a linear version of your project, updated as you work. You can export the 
report to a variety of formats, or change the style of the report using the 
drop-down list on the Reports tab or by clicking and tweaking the style in 
the Report Preferences dialog box. 

 
You can switch the Master Storyline view on using View | Master 

Storyline, so you can see the overall shape of your story. 
 
As well as a description (brief facts about the scene or incident you are 

dealing with at this point in the story), you can use the Content, Setting,
Annotation and Image tabs to enter more details for each card. 

 
The Content tab can have as much detail as you want – perhaps the 

entire scene. We have included some simple screenwriting formatting 
commands so that you can really run with an idea if you wish to. Click on the 

button to see a summary of these commands. 
 

The Setting tab allows you to specify location and time details. 
 
The Annotation tab lets you write notes about the scene or incident, 

and the card will show a yellow corner if there is an annotation. 
 
The Image tab lets you associate an image with the card, from a file or 

pasted from the clipboard. The image will show on the card depending on 
options you set in the Preferences dialog. 
 

The elements 
of StoryLines
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Left-click on a card to edit it (on the Mac, just click), and right-click on a card 
to popup a context menu with commands that apply to this card (on the Mac, 
use control-click). 
 

Cards can be dragged individually using the left mouse button, or you 
can select several by left clicking on the card’s coloured bar with control held 
down (hold down shift on Mac) or by dragging a selection box around a 
group of cards, or by choosing Select All on the context menu (also by 
Ctrl+A). You can deselect cards using the context menu, or by clicking 
anywhere on the window background. 

 
Undo and Redo can be applied to most commands. This can be 

handy when you've dragged a card somewhere you didn't want to, for 
example, and want to quickly revert to the previous position. 

 
A card can have the navigation focus as well as be selected. There is 

only ever one card with the focus, and it is highlighted by a flashing colour 
bar. When you create a new card with Ctrl+N or the Edit | New Card 
command, it is created after the focus card in an available column or in a 
newly created column. 

 
You can navigate around the storyline window with the keyboard arrow 

keys, using Alt+Left, Alt+Right, Alt+Up, and Alt+Down. The current focus 
will be set to the first card in the specified direction. Alt+Home and Alt+End 
will take you to the start and the end of the storyline window respectively. 

 
You can insert a column in front of the focus card with Alt+Insert, and 

delete selected cards or the focus card using Alt+Delete.

Columns can have labels: left-click on a column number to edit a label, 
and press Return to finish editing the label. Column labels will often contain 
a date or time; but you might wish to use a more qualitative term. 

 
You can divide your project into numbered sections. Insert a new 

section marker by left-clicking near the top of a column and entering some 
text (or leaving the section name blank). A context menu that pops up when 
right-click over the section label allows you to delete or move the section 
marker (on the Mac, use control-click). Note that you can only delete the first 
section marker if there are no other sections present. 

 
You can Copy , Cut and Paste cards, so long as the storyline 

window is focused and not a text field. Click on the storyline window 
background to ensure that the focus is on the window. 
 

A lot of important information 
about the project is edited and 
viewed in the Project 
Information Dialog, which you 
can open by clicking on (or 
Edit | Project Information, or 
Ctrl+L). Here you can edit a 
description of your story, and 
create, delete or rename your 
storylines. You can also fill out 
profiles for your characters and 
locations.  
 

Advanced 
editing

Editing story 
details, and 

character and 
location 
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After selecting a suitable report style for 
your project, you can preview it by 
clicking on , and print it by clicking on 

. You can also export it to a number 
of formats, including OpenOffice.org 
Writer: screenplay formatting styles will 
be preserved so you can continue to 
apply the appropriate styles as you 
refine your story. 
 

The level of detail shown in a report, 
as well as the visual styles, can be 
changed in the Report Style Dialog 
(above). You can create your own report 
styles to show exactly the content you 
wish. If you wish to print out your story 
using a similar layout to the storyline 
window, you can choose the tabular 
format (shown here), which displays the 
card text in columns as if the storyline 
window were rotated by 90 degrees. There is a Tabular report style provided 
using this format, but you can also enable or disable this format for any 
report. 
 

There are two established schools of thought about starting a project. On the 
one hand there is the school of meticulous planning that considers it a sin to 
start chapter one or scene one until everything is worked out down to the 
last plot twist. The other school tells you to plunge right in and just do it, 
trusting to instinct and inspiration. The first method means you are well 
prepared, but can trap you by giving you too rigid a blueprint for your story. 
On the other hand, the second method means you can find yourself lost in a 
fictional desert without a map or a clue.  
 

Storylines can help you to avoid the pitfalls of both systems and lets you 
harvest their respective strengths. When you are planning your intricate plot 
and you feel you have to write a particular scene out in full, you can switch to 
the content section of a card, and go with the flow. If, on the other hand, you 
are exploring the substance of your story by writing actual scenes and 
suddenly the best ending ever occurs to you, it’s easy to play with the cards 
and get on top of the structural demands of your story. Whichever way you 
like to play it, StoryLines is there to help you. 

This brief guide can only scratch the surface of Writer’s Café Desk and 
StoryLines, but we hope it has given you sufficient information for you to get 
stuck in and explore the tools, samples and online help. If in doubt, 
remember the button in Writer’s Café Desk, and the context-sensitive 
help buttons  and plus the Help button on each dialog box. If the 
manuals don’t help with a particular problem, do pop by the Writer’s Café 
support pages and see if the question is already answered: if not, post your 
question to the mailing list or to us directly and we’ll respond. 

Printing and 
exporting 

reports

StoryLines 
suits your 

style

Where next?
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These are the shortcuts you can use to accelerate your use of Writer’s Café 
Desk. 
 

Ctrl + A Selects all text in an edit control. 
Ctrl + C If a text control is selected, copies the selected text to the clipboard. If an image 

scrap is selected, the image is copied to the clipboard. 
Ctrl + M Shows the File Manager, for easy back-up and other file related activities. 
Ctrl + N Creates a new scrapbook. 
Ctrl + O Opens a scrapbook. 
Ctrl + P Shows the print dialog for printing the current scrapbook or scrap, or journal. 
Ctrl + S Saves the active Writer's Café scrapbook and all its contents. 
Ctrl + T Shows the Settings dialog.   
Ctrl + U Opens a URL (web address). 
Ctrl + V Pastes text or an image from the clipboard to the text control or image scrap. 
Ctrl + X If a text control is selected, copies the selected text to the clipboard and deletes 

the text. 
Ctrl + Y Redoes the previously undone edit in a text field or collage scrap. 
Ctrl + Z Undoes the previous edit in a text field or collage scrap. 
Ctrl + Backspace Goes back a page in the embedded web browser. 
Ctrl + Page Up Goes to the previous journal entry or notebook page. 
Ctrl + Page Down Goes to the next journal entry or notebook page. 
Alt + B Shows the Bookshelf tab. 
Alt + C Shows the Café Menu tab. 
Alt + J Displays the Journal tab. 
Alt + K Shows the Cookies tab. 
Alt + L Shows the StoryLines tab. 
Alt + N Shows the Notebook tab. 
Alt + P Shows the Writing Prompt dialog. 
Alt + S Shows the Scraps tab. 
Alt + T Goes to today’s journal entry. 
Alt + W Shows the Web tab. 
Alt + X Deletes the active scrap. 
Alt + Enter Shows the current scrap properties dialog. 
Alt + F4 Closes Writer’s Café Desk. 
Alt + Up Goes to the previous scrap. 
Alt + Down Goes to the next scrap. 
Ctrl + Alt + C Creates a collage scrap. 
Ctrl + Alt + F Creates a folder scrap. 
Ctrl + Alt + I Creates an image scrap. 
Ctrl + Alt + S Creates a shortcut scrap. 
Ctrl + Alt + T Creates a text scrap. 
Ctrl + Alt + V If there is image data on the clipboard, it will be pasted into a new image scrap. 

If there is a web address on the clipboard, a new web link scrap will be created. 
If there are multiple lines of text on the clipboard, a new text scrap is created. 

Ctrl + Alt + W Creates a web link scrap. 
F5 Reloads the current browser page. 
F10 Shows a slideshow of all image scraps below the currently selected scrap. 
F11 Shows the Timer dialog. 
F12 Checks the notebook or journal for spelling mistakes. 

Keyboard 
Shortcuts for 

Writer’s Café Desk
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You can make your StoryLines experience smoother by using keyboard 
shortcuts. Note that some shortcuts are dependent on context: that is, which 
window has the focus. For example, if you are typing text into a card, Undo 
and Redo affect the text field, while if the storyline window has the focus, 
Undo and Redo apply to edits such as card creation, deletion and moving. 
 

Ctrl + A Storyline window: selects all cards. Edit field: selects all text. 
Ctrl + B Plays the Forty Thieves patience game to relax your mind. 
Ctrl + C Edit field: copies any selected text to the clipboard. Storyline window: selected cards are 

copied to the internal clipboard. Set the focus to the storyline window by left-clicking on it. 
Ctrl + E Exports the project to a file using the current report style. 
Ctrl + F Shows the Find window, for searching through card text. 
Ctrl + G Generates the report, if not in auto-generate mode. 
Ctrl + H Shows the thesaurus (Windows only). 
Ctrl + I Imports a text file into the Project Notes area. 
Ctrl + K Shows the Pockets Dialog. 
Ctrl + L Shows the Project Information Dialog 
Ctrl + M Shows the card properties dialog for the focused card, if any. 
Ctrl + N Creates a new card on the currently selected storyline. 
Ctrl + O Opens a StoryLines file. 
Ctrl + P Prints the current StoryLines project. 
Ctrl + R Shows the Find and Replace window for searching through cards and replacing text. 
Ctrl + S Saves the current StoryLines project. 
Ctrl + T Shows the Preferences Dialog. 
Ctrl + V Edit field: pastes text from the clipboard to the field. Storyline window: pastes any cards in 

the internal clipboard in front of the focused card, or at the current pointer position. 
Ctrl + W Closes the current StoryLines project. 
Ctrl + X Edit field: cuts any selected text and copies it to the clipboard. Storyline window: the 

selected cards are copied to the internal clipboard and then deleted. You can set the 
focus to the storyline window by left-clicking on it. 

Ctrl + Y Storyline window, edit field: redoes the previously undone edit. 
Ctrl + Z Storyline window, edit field: undoes the previous edit. 
Ctrl + Tab Cycles through the tabs in the card editor window. 
Del Edit field: deletes the selected text, or if none selected, the next character. 
Alt + I Shows the Card Icons dialog for associating icons with the current card. 
Alt + F4 Closes StoryLines. 
Alt + Home Goes to the beginning of the storyline window. 
Alt + End Goes to the end of the storyline window. 
Alt + Left Goes to the previous card on the current storyline. 
Alt + Right Goes to the next card on the current storyline. 
Alt + Up Goes to the previous card on the current column. 
Alt + Down Goes to the next card on the current column. 
Alt + Insert Inserts a new column at the focused card. 
Alt + Delete Deletes the selected card(s) or focused card. 
Esc Leaves column label or section label editing. 
Return Leaves column label or section label editing. 
F2 Shows the card description window. 
F3 Shows the card content window. 
F4 Shows the card setting window. 
F5 Shows the card annotation window. 
F6 Shows the report window. 
F7 Shows or hides the edit and outline windows. 
F8 Shows the Floating Card Editor, allowing you to edit different parts of a card at once. 
F9 Shows the card image tab. 
F12 Checks your project for spelling mistakes. 

Keyboard 
Shortcuts for 

StoryLines


